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Safety Practices and Hazards 

Your Varian instrument and accessories have been carefully 
designed so that when used properly you have an accurate, fast, 
flexible and safe HPLC system. 
Information about safety practices appears throughout the 
documentation (both hard copy and online) provided with your 
instrument. Before using the instrument, you must thoroughly read 
these safety practices. 
Observe all relevant safety practices at all times.  
This instrument is designed for chromatographic analysis of 
appropriately prepared samples. It must be operated using 
appropriate solvents and within specified maximum ranges for 
pressure, flows, and temperatures as described in this manual. If 
the equipment is used in a manner not specified by the 
manufacturer, the protection provided by the equipment may be 
impaired. 
It is your responsibility to inform Varian representatives if the 
instrument has been used for the analysis of hazardous biological, 
radioactive, or toxic samples, prior to any instrument service being 
performed or when an instrument is being returned to the service 
center for repair, or is being recycled at end-of-life. 

General 
Operation of a Varian 900-LC Series Liquid Chromatograph 
involves the use of pressurized liquid, ultraviolet radiation, and 
hazardous materials including corrosive fluids and flammable 
liquids. Careless, improper or unskilled use of this liquid 
chromatograph can cause death or serious injury to personnel, 
and/or severe damage to equipment and property. 
The 900-LC Series Liquid Chromatograph incorporates covers that 
are designed to prevent inadvertent contact with any potential 
hazards. If the instrument is used in any manner not specified by 
Varian, this protection may be impaired. It is essential that no 
cover is bypassed, damaged or removed. 
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The safety practices described below are provided to help the user 
operate the instrument safely. Read each safety topic thoroughly 
before attempting to operate the instrument and ALWAYS operate 
the liquid chromatograph in accordance with these safety 
practices. 
Follow these safety practices to ensure safe equipment operation. 
• Perform periodic leak checks on all supply lines and pneumatic 

plumbing. 
• Do not allow liquid lines to become kinked or punctured. Place 

lines away from foot traffic and extreme heat or cold or ignition 
sources. 

• Store organic solvents in fireproof, vented and clearly labeled 
cabinets so they are easily identified as toxic and/or flammable 
materials. 

• Keep the waste vessel in view and empty as required. 
• Do not accumulate waste solvents. Dispose of such materials 

through a regulated disposal program and not through 
municipal sewage lines. 

This instrument has been tested per applicable requirements of 
EMC Directive as required to carry the European Union CE 
Marking. This equipment may be susceptible to 
radiation/interference levels or frequencies, which are not within 
the tested limits. 

Electrical Hazards 
Exposure to high voltages and UV energy can cause severe skin 
damage and cataracts of the eyes, while close contact with the 
electrical components can result in severe heat burns to the skin, 
and an electrical discharge which may cause death, severe electric 
shock or sub-surface skin burns. 
The 900-LC Series Liquid Chromatograph has been carefully 
designed to operate safely and effectively when using components 
that conform to Varian’s design criteria. Use of non-approved 
components in the HPLC system may render the system 
inoperative and/or hazardous. It may also invalidate the warranty 
on the instrument. Use only related components supplied or 
authorized by Varian. 
• Disconnect the instrument from all power sources before 

removing protective panels to avoid exposure to potentially 
dangerous voltages. Panels or covers which are retained by 
screws on the HPLC system may be opened ONLY by Varian-
trained, Varian-qualified, or Varian-approved Representatives. 
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Consult the manuals or product labels supplied with your PC to 
determine which parts are operator-accessible. 

• When it is necessary to use a non-original power cord plug, 
make sure the replacement cord adheres to the color coding 
and polarity described in the manual and all local building 
safety codes. 

• Good grounding/earthing is essential to avoid a potentially 
serious electric shock hazard. Consult the manuals or product 
labels supplied with your PC for the relevant grounding 
requirements. 

• Replace blown fuses with fuses of the size and rating shown 
on the fuse panel or in the manual. 

• Replace faulty or frayed power cords immediately with the 
same type and rating. 

• Make sure that voltage sources and line voltage match the 
value for which the instrument is wired. 

• Avoid using power supplies from a source that may be subject 
to electrical or RF interface from other services (for example, 
large electrical motors, elevators and welders). 

Compressed Gas Cylinders 
Unless your system is equipped with a helium sparging unit or an 
ELS detector, there are no gas requirements for the 900-LC Series 
HPLC systems. For gas requirements on these devices, consult 
the Operation Manual or other documentation enclosed with the 
particular device. Compressed gas cylinders contain highly 
pressurized gas. If storage conditions are outside of the 
recommended suppliers safety codes the cylinders can explode or 
rapidly release gas into the environment. This may result in injury 
or death. 
• Store and handle compressed gases carefully and in strict 

adherence to safety codes. 
• Secure cylinders to an immovable structure or wall. 
• Store and move cylinders in an upright, vertical position. Before 

transport, remove regulators and install cylinder cap. 
• Store cylinders in a well ventilated area away from heat, direct 

sunshine, freezing temperatures, and ignition sources. 
• Mark cylinders clearly so there is no doubt as to their contents. 
• Use only approved regulators and connections. 
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• Use only connector tubing that is chromatographically clean 
(Varian part number 0391832600) and has a pressure rating 
significantly greater than the highest outlet pressure from the 
regulator. 

Storage Cylinder Instructions 
Cylinders containing gas under pressure should be firmly secured 
to a rigid structure, and the storage area must be adequately 
ventilated. 
Never locate gas cylinders near a source of ignition, or in a 
position that is subject to direct heat. Gas storage cylinders often 
incorporate a pressure release device which will discharge the gas 
at a predetermined temperature, usually around 52 °C (125 °F). 
If gases are to be plumbed from a remote storage area to the 
instrument site, ensure that the local outlets are fitted with stop 
valves, pressure gauges and suitable regulators which are easily 
accessible to the instrument operator. The gas outlets must be 
provided within 1.5 metres (5 feet) of the instrument. 

High Pressure Hazards 
If a line ruptures, a relief device opens, or a valve opens 
accidentally under pressure, potentially hazardous high liquid 
pressures can be generated by the pump causing a high velocity 
stream of volatile and/or toxic liquids. 
• Wear personal protective equipment when you inject samples 

or perform routine maintenance. 
• Never open a solvent line or valve under pressure. Stop the 

pump first and let the pressure drop to zero. 
• Read and adhere to all NOTES, CAUTIONS, and WARNINGS 

in the manual. 
• Always keep the doors and covers closed during operation. 

Ultraviolet Radiation 
900-LC Series Liquid Chromatograph systems that use an 
ultraviolet light source have shielding to prevent radiation exposure 
to personnel. 
For continued protection: 
• Ensure that any protective lamp covers are in place during 

operation. 
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• Do not look directly into detector fluid cells or at the UV light 
source. When inspecting the light source or fluid cell, always 
use protective eye covering such as borosilicate glass or 
polystyrene. 

• Ozone can be generated by radiation from source lamps. 
Exposure to ozone can result in severe irritation to the skin, 
eyes, and upper respiratory system. The maximum permissible 
exposure level is 0.1 ppm (0.2 mg/m3). ALWAYS ventilate the 
area surrounding the HPLC system such that the concentration 
of ozone does not exceed the maximum permissible level. All 
venting must be to outside air, never within the building. 

Solvent Hazards 
The operator should be familiar with the physico-chemical 
properties of the components of the mobile phase. 
Only use solvents compatible with the HPLC system tubing and 
fittings as certain solvents may cause weakening and leaks with 
possible bursting. 
Employ static measuring and static discharge devices to safeguard 
against the buildup of static electricity. 
All solvents can create a hazard if they leak into the atmosphere. 
Even small leaks in solvent supply systems can be dangerous. Any 
leak (except that of air) can result in an oxygen-deficient 
atmosphere, which can cause asphyxiation. The area in which 
solvents are stored and the area surrounding the instrument must 
be adequately ventilated to prevent such accumulations.    

Ignition of Flammable Chemicals 
This instrument is not explosion-proof. In unattended operation, do 
not use organic solvents having an ignition point below 70 °C. 
If a flammable chemical such as organic solvent leaks from the 
flow path of the instrument and its vapor concentration reaches the 
explosion limit, it could cause spontaneous combustion with 
dangerously explosive results.  
Beware of ignition hazard when using flammable chemicals such 
as organic solvents.  
Do not bring a heat or flame source near the instrument.  
Ventilate the laboratory room where the instrument is used.  
Always check the following conditions. If an abnormality is found, 
stop operation immediately. 
• Leakage of solvent or waste solution.  
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• Leakage of solvent inside the instrument.  
When using flammable chemicals, be careful about possible 
ignition due to static electricity. To prevent the build-up of static 
electricity, use a conductive container for waste.  
Use only approved regulator and hose connectors (refer to the 
supplier’s instructions). Keep solvents cool and properly labeled. 
Ensure that you have the correct solvent before connecting it to the 
instrument. 

Inflammation or Injury Due to Toxic, Corrosive 
or Stimulative Solvent 
When using a toxic, corrosive or stimulative solvent, be careful not 
to contact solvent to prevent physical inflammation or injury. For 
details of the properties of each solvent and how to handle it, refer 
to the relevant Material Safety Data Sheets (MSDS). Be sure to 
handle each solvent properly.  
Wear proper personal protective clothes (e.g., safety goggles) so 
that a solvent will not come into direct contact with the skin.  
Ventilate the laboratory room adequately to prevent accidental 
inhalation of harmful solvent vapor. 

Other Precautions 
Use of the 900-LC Series Liquid Chromatograph and accessories 
may involve materials, solvents and solutions, which are 
flammable, corrosive, toxic or otherwise hazardous. Careless, 
improper or unskilled use of such materials, solvents and solutions 
can create explosion hazards, fire hazards, toxicity and other 
hazards that can result in death, serious personal injury or damage 
to equipment. 
Always ensure that laboratory safety practices governing the use, 
handling and disposal of hazardous materials are strictly observed. 
These safety practices should include wearing appropriate safety 
clothing and safety glasses. 
Airflow to the cooling fans of the liquid chromatograph must be 
unobstructed. Do not block the ventilation grills on the liquid 
chromatograph and accessories. Consult the manuals supplied 
with your PC, monitor and for their specific ventilation 
requirements. 
Great care should be taken when working with glass or quartz 
parts to prevent breakage and cuts. 
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The 900-LC Series Liquid Chromatograph weighs approximately 
130 kg (287 lb). To avoid injury to personnel or damage to the 
instrument or property, always use appropriate lifting procedures to 
move the instrument. 
Use only Varian-supplied spares with your instrument. 

Warning and Caution Messages 
A Warning message is used in the text when failure to observe 
instructions or precautions could result in death or injury. The list of 
symbols that appear in conjunction with warnings are detailed in 
the next section. 
A Caution message is used when failure to observe instructions 
could result in damage to equipment (Varian supplied and/or other 
associated equipment). 
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Warning Symbols 
The following is a list of symbols that appear in conjunction with 
warnings in this manual or on the 900-LC Series Liquid 
Chromatograph. The hazard they describe is also shown. 
A triangular symbol indicates a warning. The meanings of the 
symbols that may appear alongside warnings in the documentation 
or on the instrument itself are as follows: 

 
Corrosive liquid 

 
Electrical shock  

 
Explosion hazard  

  
Eye hazard 

 
Fire hazard  

  
Heavy weight 

(danger to feet) 

 
Heavy weight 

(danger to hands) 

 
Hot surface  

 
Moving parts  

  
Radiation source  

 

 

 

The following symbol may be used on warning labels attached to 
the instrument. When you see this symbol, refer to the relevant 
operation or service manual for the correct procedure referred to 
by that warning label. 
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The following symbols appear on the instrument for your 
information. 

 

Mains power on/off button. Press the power 
button in and release it to turn it on. Press the 
power button in for 5 seconds and then release it 
to turn the HPLC system off. There may be a 
short delay between releasing the power button 
and instrument shut down. 

 Fuse 

 Single phase alternating current 

 Direct current 

 

When attached to the rear of the instrument, 
indicates that the product complies with the 
requirements of one or more EU directives. 

 

When attached to the rear of the product, 
indicates that the product has been certified 
(evaluated) to CSA 1010.1 and UL 3101-1. 

Color Coding 
The various indicator lights appearing on Varian instruments and 
associated accessories are color coded to represent the status of 
the instrument or accessory. 
• A green light indicates the instrument is in normal/standby 

mode. 
• An orange light indicates that a potential hazard is present. 
• A blue light indicates that operator intervention is required. 
• A red light may warn of danger or an emergency. 

US FCC Advisory Statement 
This equipment generates, uses and can radiate radio frequency 
energy, and if not installed and operated in accordance with the 
instruction manual may cause interference to radio 
communications. It has been tested and found to comply with the 
limits for a Class A computing device pursuant to Subpart J of Part 
15 of Federal Communications Commission (FCC) Rules, which 
are designed to provide reasonable protection against such 
interference when operated in a commercial environment. 
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Operation of this equipment in a residential area may cause 
interference, in which case the user will be required to take 
whatever measures may be necessary to correct the interference 
at his or her expense. 

Spurious and Harmonic Radiation Compliance 
Your Varian 900-LC Series Liquid Chromatograph complies with 
the requirements of FCC rules and Regulations part 18, subpart 
H—Miscellaneous Equipment, at the date of manufacture. 

CE Compliance 
Your Varian 900-LC Series Liquid Chromatograph has been 
designed to comply with the requirements of the Electromagnetic 
Compatibility (EMC) Directive and the Low Voltage (electrical 
safety) Directive (commonly referred to as the LVD) of the 
European Union. Varian has confirmed that each product complies 
with the relevant Directives by testing a prototype against the 
prescribed EN (European Norm) standards. 
Proof that a product complies with these directives is indicated by: 
• The CE Marking appearing on the rear of the product, and 
• The documentation package that accompanies the product 

containing a copy of the Declaration of Conformity. The 
Declaration of Conformity is the legal declaration by Varian that 
the product complies with the directives listed above, and 
shows the EN standards to which the product was tested to 
demonstrate compliance. It is also signed by Varian’s 
Authorized Representative in the EU, and by the representative 
of the manufacturing plant. 
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1. Introduction 

1.1 Pre-installation Requirements 
Prior to receiving your instrument, you will have been provided with 
a 900-LC Series Liquid Chromatograph Pre-installation Manual 
(publication number 8510243900), which describes the 
environmental and operating requirements of the HPLC system. 
You must prepare your laboratory according to these instructions 
before the HPLC system can be installed. You should keep the 
pre-installation manual for future reference. If you have misplaced 
your copy, you can obtain a free replacement from your local 
Varian office. Alternatively, download a PDF from the Varian, Inc. 
Web site, www.varianinc.com 

1.2 User Documentation 
You have been provided with the following documentation to help 
you set up and operate your Varian 900-LC Series Liquid 
Chromatograph: 
• This Getting Started manual, with safety practices and hazards 

information, where to find information about installing and 
maintaining instrument components and a brief operation 
overview. 

• An extensive online Help system containing context-sensitive 
help, step-by-step instructions for frequently performed 
operations and instructions for using any accessories you 
ordered. 

1.2.1 Conventions 
The following conventions have been used throughout the 
documentation: 
• Menus, menu options and field names (e.g. select Copy from 

the Edit menu) have been typed in bold. Bold is also used to 
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signify the pushbuttons appearing throughout the software (e.g. 
click OK). 

• ALL CAPITALS indicate keyboard and mouse commands (e.g. 
press the F2 key) and text you must type in from the keyboard 
(e.g. type SETUP at the prompt). 

1.2.2 Notes and Hot Tips 
A Note is used to give advice or information. A Note is denoted by 
the following symbol: ✒ 
A Hot Tip is used to give practical hints to help you achieve the 
best possible performance from your instrument. A Hot Tip is 
denoted by the following symbol: ✰✰✰ 

1.3 Specifications 
The instrument is suitable for indoor use only and is classified 
suitable under the following categories (EN 61010-1): 
Installation category II 
Pollution degree 2 
Safety class 1 

1.3.1 Environmental Conditions 
Condition Altitude Temp 

(°C) 
Humidity (%RH)  
non-condensing 

Non-operating 
(Transport) 

0–3 050 m 
(0–10 000 ft) 

5–45 20–80 

Non-operating & 
meeting 
dielectric 
strength tests 

Sea level 40 90–95 

Operating within 
specifications 

0–2 000 m 
(0–6 560 ft) 

10–35 8–80 

Table 1. Environmental conditions 

✒ Note For optimum analytical performance, it is recommended that the 
ambient temperature of the laboratory be between 20 and 25 °C 
and be held constant to within ±2 °C throughout the entire working 
day. 
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1.3.2 Electrical Power Supplies 
All power supplies should be single phase AC, 3 wire system 
(active, neutral, ground or two active and ground) and should be 
terminated at an appropriate connection receptacle that is within 
reach of the system power cable. 

1.3.2.1 900-LC Series HPLC System Power Connections 
Power supply phase Single 

Power supply, current rating 
and overload protection 

Between 3 and 5 A (for 220-240 V countries) 
Between 6 and 12 A (for 100-120 V countries)

 
 Plug supplied Required wall socket 
Australia Complies with AS3112 To comply with AS3112 

HPM 787 or Clipsal 2015 (250 V, 10 A)

USA Complies with Nema 5-15P To comply with Nema 5-15R 

Hubbell 5262 (125 V, 15 A) 

Canada Complies with Nema 5-15P 

Complies with CS 22.2 No. 42 

To comply with Nema 5-15R 

Hubbell 5262 (125 V, 15 A) 

Europe Complies with CEE 7 Sheet VII To comply with CEE 7 Sheet VII  
(250 V, 10/16 A) 

Table 2. Power connections 

1.3.2.2 Fuses 
1FS1 & 1FS2 T10 A H250 V, 3AB SLO-BLO (for 220-240 V countries) 

T20 A H250 V, 3AB SLO-BLO (for 100-120 V countries) 

FS3 T2.5 A H250 V, 5x20 mm (for both 100-120 V and 220-240 V 
countries) 

Table 3. Fuses 

✒ Note For safety reasons, any other internal fuses or circuit breakers are 
not operator accessible, and should only be replaced by Varian-
authorized personnel. 
Fuse information on the rear of the instrument is the most up to 
date. 
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1.3.2.3 Electrical Requirements 
The installation of electrical power supplies must comply with the 
rules and/or regulations imposed by the local authorities 
responsible for the use of electrical energy in the workplace. 
All power supplies for the 900-LC Series Liquid Chromatograph 
and accessories should be single phase, AC, 3 wire systems 
(active, neutral, ground or two active and ground). Each 
connection should be terminated at an appropriate receptacle 
within reach of each assembly’s power cable. Use of power boards 
or extension cables is not recommended. 
Avoid using power supplies from a source that may be subject to 
electrical interference from other services (such as large electric 
motors, elevators, centrifuges and air conditioning units). The 
Varian 900-LC Series Liquid Chromatographs are supplied with a 2 
meter long (6 ft 6 in), mains supply cable. 

System unit Required supply voltage Nominal rating

920-LC Analytical Liquid Chromatograph 100-120, 220-240 V AC, 50-60 Hz 1000 VA 

940-LC Semi-Preparative Liquid 
Chromatograph 

100-120, 220-240 V AC, 50-60 Hz 800 VA 

940-LC Preparative Liquid Chromatograph 100-120, 220-240 V AC, 50-60 Hz 1200 VA 

Fraction Collector 115-230 V AC, 50-60 Hz 264 VA 

External ELS Detector 115-230 V AC, 50-60 Hz 480 VA 

External RI Detector 115-230 V AC, 50-60 Hz 150 VA 

Ethernet Switch 115, 220 or 240 V AC, 50-60 Hz 7 VA 

Personal computer (Typical) 115, 120, 220, 240 VAC  300 VA 

Printer (Typical) 115, 120, 220, 240 VAC 85 VA 

Table 4. Power requirements 

1.3.3 Gas Supplies 
The installation of compressed or liquid gas supplies must comply 
with the rules and/or regulations imposed by the local authorities 
responsible for such use in the workplace. 
The main gas supply requirement is nitrogen for supply to ELS 
Detector. Nitrogen from a cylinder or nitrogen generator may be 
used with Varian 900-LC Series Liquid Chromatograph ELS 
Detector.  
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 Nitrogen Gas 

Purity >98% filtered to 0.2 µm 

Permissible pressure 
range  

60 to 100 psi 
(4–6.7 bar) 

Maximum pressure 100 psi (6.7 bar) regulated 

Required flow rates Up to 3.25 L/min at 60 psi at 25 °C 

Table 5. Gas requirements 

Helium may also be required to if you are using a helium sparging 
system to degas solvents. Consult the documentation that came 
with your helium sparging system for gas requirements. 

1.3.3.1 Storage Cylinder Instructions 
Cylinders containing gas under pressure should be firmly secured 
to a rigid structure, and the storage area must be adequately 
ventilated. 
Never locate gas cylinders near a source of ignition, or in a 
position that is subject to direct heat. Gas storage cylinders often 
incorporate a pressure release device which will discharge the gas 
at a predetermined temperature, usually around 52 °C (125 °F). 
If gases are to be plumbed from a remote storage area to the 
instrument site, ensure that the local outlets are fitted with stop 
valves, pressure gauges and suitable regulators which are easily 
accessible to the instrument operator. The gas outlets must be 
provided within 1.5 meters (5 feet) of the instrument. 

1.3.4 Waste Container 
The Varian 900-LC Series Liquid Chromatograph needs a drain 
vessel for disposal of fluids and vapors from the system. Suitable 
tubing is supplied with the HPLC system for use with most HPLC 
solvents. Always check that your HPLC system tubing is 
compatible with your solvents. 
A chemically inert container, not glass and not sealed, to hold a 
minimum of 2 liters (4 pints) of waste must be provided by the 
user. Narrow necked containers are preferred. The waste vessel(s) 
should be bonded. It should be placed where it is protected by the 
bench and in full view of the operator. 

Publication no. 8510243600, Issue 1, February 2008  Page 15 of 54 



Varian 900-LC Series Liquid Chromatograph 

1.3.5 Laboratory Conditions 
The area selected for the operation of a Varian HPLC system 
must be free from drafts, corrosive atmospheres and 
vibration. Sample preparation areas and materials storage 
facilities should be located in a separate room. 
The area should be a dust-free, low humidity environment.  
Air-conditioning is strongly recommended for control of the 
environment. For optimum analytical performance it is 
recommended that the ambient temperature of the laboratory is 
between 20 and 25 °C (68 and 77 °F). 

1.3.6 Instrument Cooling Air Supply 
Air is drawn from the front of the instrument and out the back to 
cool the electronics of the instrument. Several of these assemblies 
contain parts prone to corrosion. The introduction of cooling air 
contaminated with high levels of acid, vapors or other corrosive 
substances may cause damage to the instrument. 
Due to the corrosive nature of some work, it is recommended that 
in applications demanding high usage of corrosive materials, an 
external cooling air supply system is provided. It is recommended 
that the cooling air be supplied from an environmentally controlled 
area that is away from the instrument exhaust and any other area 
where corrosive materials are stored or used. 

1.3.7 Weights and Dimensions 
System Unit Width Depth Height Weight 

Varian 920-LC Analytical Liquid Chromatograph 750 mm
30 in 

725 mm
29 in 

665 mm 
27 in 

115 kg 
254 lb 

Varian 940-LC Semi-Preparative Liquid Chromatograph 750 mm
30 in 

725 mm
29 in 

665 mm 
27 in 

125 kg 
276 lb 

Varian 940-LC Semi-Preparative Liquid Chromatograph 
with Scale Up Module 

750 mm
30 in 

725 mm
29 in 

856 mm 
34 in 

130 kg 
287 lb 

Varian 940-LC Preparative Liquid Chromatograph 750 mm
30 in 

725 mm
29 in 

665 mm 
27 in 

115 kg 
254 lb 

Shipping dimensions for all HPLC systems 950 mm
38 in 

895 mm
36 in 

1165 mm 
46 in 

170 kg 
375 lb 
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Computer and Printer 

Computer (typical) 450 mm 
18 in 

770 mm 
30 in 

520 mm 
20 in 

(n/a) 

Laser printer (typical) 500 mm 
18 in 

650 mm 
30 in 

200 mm 
20 in 

(n/a) 

 

External Options/Devices 

Fraction Collector 400 mm 
16 in 

600 mm 
24 in 

480 mm 
19 in 

18 kg 
34 lb 

Shipping dimensions 760 mm 
30 in 

500 mm 
20 in 

600 mm 
24 in 

31 kg 
69 lb 

Refractive Index Detector 296 mm 
12 in 

385 mm 
15 in 

212 mm 
9 in 

11 kg 
25 lb 

Shipping dimensions 775 mm 
31 in 

475 mm 
19 in 

460 mm 
18 in 

14 kg 
31 lb 

ELS Detector 200 mm 
8 in 

360 mm 
14 in 

415 mm 
17 in 

11 kg 
25 lb 

Shipping dimensions 700 mm 
28 in 

450 mm 
18 in 

600 mm 
24 in 

18 kg 
40 lb 

Table 6.  900-LC Series Liquid Chromatograph and options dimensions 

 

 

Warning 
The HPLC system weighs up to 130 kg (287 lb). To avoid injury 
to personnel or damage to equipment, always use a forklift or 
other suitable lifting device when moving the instrument. 

1.4 Personal Computer Requirements 
The recommended and minimum PC specifications are listed in the 
following table. They can also be found on Varian’s Web site at 
www.varianinc.com. The minimum configuration represents the 
absolute minimum that is required to run the Galaxie™ software. 
This PC configuration may be out of manufacture, but you may 
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want to use a PC you already have. The recommended 
configuration should be followed when buying a new PC. 

Minimum Recommended 

Pentium 4 processor, 2.8 GHz or 
higher 

Core 2 Duo, 2.13 GHz or higher 

1 GB of RAM 2 GB of RAM 

160 GB hard drive 2 x 200 GB hard drives 

16 speed CD-ROM or DVD-RW 16 speed CD-ROM or DVD-RW 

Super VGA monitor with high color (16 
bit) display, 1024 x 768 resolution, 
minimum 17” monitor 

Super VGA monitor with high color (16 
bit) display, 1024 x 768 resolution, 
minimum 17” monitor 

16 bit sound card 16 bit sound card 

Windows® compatible keyboard Windows® compatible keyboard 

Microsoft® or compatible mouse Microsoft® or compatible mouse 

Two PCI-compatible slot for I/O card Two PCI-compatible slot for I/O card 

Windows® XP SP 1 Windows® XP SP 1 

Microsoft® Internet Explorer® v6.0 Microsoft® Internet Explorer® v6.0 

Table 7. Recommended PC specifications 

*For Galaxie™ CDS server specifications please contact your local 
Varian sales representative. 
PCs supplied with Letter of Credit orders will be an international 
brand and will be the ‘Recommended’ configuration or better. 
Higher rated PC components can be substituted for those listed 
above e.g., processor type, amount of memory, screen size and 
resolution, operating system version etc. 
For the latest PC and video card recommendations please see the 
Varian, Inc. website at www.varianinc.com 
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2. Installation 

The Varian 900-LC Series Liquid Chromatograph must be installed 
by a Varian-trained, Varian-qualified or Varian-authorized 
representative. 
You should have completed and returned the form in the  
pre-installation manual stating that you have prepared the 
laboratory in accordance with the requirements detailed in that 
manual. A Varian representative will then arrange a suitable 
installation date with you. 
Details for unpacking the instrument and what to do in case it has 
been damaged in transit are also outlined in the pre-installation 
manual. 
Basic installation involves: 
• Setting up the HPLC system to PC communications 
• Installing the Galaxie™ software 
• Installing the Driver and Online Help 
• Installing the hardware 
• Running the system test 
• Basic customer training 

2.1 900-LC Series HPLC System to PC Communications 
The company network must allow TCP/IP communications 
between the client, acquisition server and HPLC systems. 
However a desktop switch is provided with the instrument, to allow 
local networking. The following are suggested network connections 
using the provided switch. 
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Figure 1. Single 900-LC Series HPLC System in standalone configuration with network 
connection 

 
Figure 2. Single 900-LC Series HPLC System in standalone configuration with no network 
connection. You must use a static IP address in this configuration. 
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Figure 3. Multiple 900-LC Series HPLC Systems in standalone configuration 

Up to four systems can be controlled by one Galaxie Acquisition 
Server. For a client server system there will need to be a PC with 
the Galaxie Acquisition Server running for every four HPLC 
systems. 

Figure 4. Networked multiple 900-LC Series HPLC System configuration option 1 
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Figure 5. Networked multiple 900-LC Series HPLC System configuration option 2 

You or your network administrator must provide any hardware, 
adapters, cables, and configuration and setup work required to 
convert from the company network wiring type to 10/100 BaseT 
wiring. This hardware must comply with the IEEE 802.3 standard. 
Choose the appropriate set up for your laboratory. Use standard 
Ethernet cables. Your 900-LC Series HPLC system comes with 
two Ethernet cables and a network switch. You will need to provide 
additional cables based on your HPLC system and PC 
configuration. 
To connect the Ethernet cables: 

✒ Note You must connect the 900-LC Series HPLC system to the PC 
running the Galaxie Acquisition server via the network switch 
provided. This will ensure uninterrupted connection between these 
two devices. 

1. Connect an Ethernet cable from the Network/PC port on 
the side of the 900-LC Series HPLC system to the 
provided Ethernet switch. Consult the instructions provided 
with the switch for more information. 

Figure 6. Side of 900-LC Series HPLC. This image has been 
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rotated to show horizontal. The connections are vertical on the side 
of the HPLC system. 

2. Connect an Ethernet cable from the Ethernet switch to the 
Ethernet port on the PC(s) and/or company network. 

3. Connect the switch to your company network if required. 

2.2 Installing the Galaxie™ Chromatography Data 
System Software 

Varian recommends that you purchase a PC as part of the Varian 
900-LC Series Liquid Chromatograph package. The PC included in 
the package will come with the appropriate Windows™ operating 
system as loaded by the PC supplier. 
For instructions on installing the Windows® operating system, 
please refer to the appropriate manuals supplied with the software. 
It is your responsibility to ensure that the operating system 
software has been installed and is functional if you are supplying 
the PC or the operating system. 

✒ Note It is important to set up user profiles with permissions to access the 
Galaxie software on each PC used with the 900-LC Series HPLC 
and a user profile for the administrator to have access to the 
Galaxie Configuration Manager. 
The 900-LC Series HPLC system requires Galaxie software 
version 1.9 SP1 or greater, a serial number for either the Galaxie 
Varian HPLC Drivers or the Varian 900-LC Series Driver and the 
900-LC Series Driver software. If you do not have Galaxie 
Software version 1.9 SP1 or greater, you must upgrade to run the 
900-LC Series driver. 

✒ Note Varian will not assume responsibility for loss of data. 
Your Varian representative will connect the PC to the HPLC 
system and any factory-approved accessories purchased at 
installation. Initial instrument software installation is also included 
as part of the system installation. 
Although the Varian-trained, Varian-qualified or Varian-authorized 
representative will install the Galaxie™ software for you during the 
installation process, you may need to install the software yourself 
at some later stage, for example if you change the PC. 

2.2.1 Software Components Requiring Installation and 
Serial Numbers Used During Installation 

The table below shows which components may need to be 
installed during the installation process and which serial numbers 
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you will need to use. 

 New Galaxie Data 
Chromatography 
software and new 900-
LC Series HPLC driver 

Existing Galaxie 
CDS, existing 
Varian HPLC driver 
and new Varian 
900-LC driver 

New Galaxie CDS, 
new Varian HPLC 
driver and new 
Varian 900-LC 
driver 

Galaxie CDS X X* X 

Galaxie Varian 900-
LC Driver 

X 
(p/n 8510244200) 

N/A X 

Galaxie Varian 
HPLC Driver 

N/A X 
This serial number is 
used during the 
installation of the 
new 900-LC driver. 
(p/n 0395000491) 

X** 
This serial number is 
used twice during 
the installation of 
both the Varian 
HPLC driver and the 
900-LC driver. (p/n 
0395000491) 

Table 8. Software installation requirements and serial numbers 

*Additional instrument licenses may need to be purchased to run 
both an existing Varian HPLC and Varian 900-LC instrument at the 
same time. Please contact your local Varian representative for 
more information. Galaxie CDS will need to be installed if a new 
client, acquisition or server is to be used. 

**If you are installing both the Varian HPLC driver and the Varian 
900-LC driver on the same acquisition server, the same serial 
number will need to be entered twice, both when installing Varian 
HPLC Drivers and when installing the 900-LC Series driver. You 
will only need to purchase the one serial number. For subsequent 
installs, the serial number is recognized. 

2.2.2 Galaxie CDS Client/Server Installation Information 
There are three different components in a Galaxie CDS 
client/server installation. The three components can be installed on 
separate PCs or combined on the one PC. (See the Galaxie 
Installation manual for more information.) 
• Main server – where data and methods are stored. Configure 

only one main server when installing the Galaxie CDS 
software. 
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• Acquisition server – communicates with the hardware of the 
900-LC Series HPLC system. Up to four 900-LC systems can 
be run by one acquisition server. There can be several 
acquisition servers in a Galaxie CDS installation. 

• Client – methods are created, data viewed and reprocessed. 
There can be several clients in a Galaxie CDS installation. 

✒ Note The 900-LC Series driver must be installed on all PCs in the 
Galaxie network regardless of whether it is a main server, 
acquisition server, or client PC. System configuration should only 
be done on the acquisition server when using the 900-LC Series 
driver setup wizard. The online help must be installed on every PC 
where it may need to be viewed. 

2.2.3 Galaxie Workstation Stand-alone Installation 
Information 

When using a stand-alone configuration the software for the main 
server, acquisition server and client are installed on one PC. This 
PC can then be used to control up to four 900-LC Series HPLC 
systems. 

2.2.4 Galaxie Installation Procedure 
The 900-LC Series Driver installation has several steps: 

1. Install the Galaxie core software. 

See the Galaxie Chromatography Data System Installation 
manual for instructions to install the software and configure 
user permissions. 

2. Install other HPLC or GC drivers as required. 

This step is part of the Galaxie core installation. 

3. Install the 900-LC Series HPLC driver. 

The installation software for the 900-LC Series HPLC 
driver is a separate CD to the Galaxie software installer. 

4. Install the 900-LC Series HPLC Online Help. 

The 900-LC Series HPLC Online Help CD is a separate 
CD to the driver CD but will be requested by the driver CD 
during installation. 

5. Configure the 900-LC Series HPLC system(s) on the 
acquisition server. 
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Steps 1-2 are performed using the Galaxie CD. 
Steps 3-5 are performed using the 900-LC Series driver setup 
wizard CD and the Online Help CD. 

✒ Note Before installation you must have the HPLC system set up and 
turned on. Set up includes having the network cabling and 
hardware plugged in. 
The 900-LC Series HPLC is an Ethernet device and must be 
assigned an IP address. Contact your IT department to determine 
if you will be setting up the instrument as a dynamic or static IP 
and if you will be setting up a client/server system or a standalone 
system. 

✒ Note The IP address of the 900-LC Series HPLC system must be on the 
same subnet as the acquisition server or stand-alone PC. In 
addition, the HPLC systems must be connected to the provided 
Ethernet switch. 

✒ Note Disable the Windows® firewall on the PC(s) to be used with 
Galaxie software. This will help prevent installation and data 
collection problems. 
Prior to installation check the following: 
• Check that power management of your Ethernet network card 

is set to never allow the card to be turned off. Consult your PC 
manual for instructions. 

• In the Windows® Control Panel > Display > Screen Saver set 
the power scheme for your monitor and hard drive to Never. 

• Turn off the screen saver. 
• Turn the Windows® XP Pro SP2 firewall off. 
• Disable any virus scans. 
• Turn off Automatic Updates in the Windows® Control Panel. 

2.2.4.1 Installing the Galaxie CDS Core Software 
To install the Galaxie™ CDS core software: 

1. Please see the Galaxie Chromatography Data System 
Installation Guide, p/n 03-914948-02 for installation 
instructions. 

✒ Note The 900-LC Series HPLC Driver requires Galaxie™ software 
version 1.9 SP1 or greater. 
During the Galaxie software and Galaxie Configuration Manager is 
installation a default profile is created. The user name, admin, and 
password, galaxie, can be used to log into Galaxie Configuration 
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Manager to set up users, systems and permissions and into the 
Galaxie software to run the system. This user name and password 
can be changed in Galaxie Configuration Manager. 

2.2.4.2 Installing Galaxie or Other HPLC or GC Device Drivers 
The drivers work with the Galaxie core software to provide 
instrument control and data acquisition. These instructions will 
provide information to install drivers other than the 900-LC Series 
HPLC driver. Go to the next section, Installing the 900-LC Series 
HPLC Driver, if this procedure is not required. 
To install Galaxie or other HPLC or GC device drivers: 

1. Please see the Galaxie Chromatography Data System 
Installation Guide, p/n 03-914948-02 for installation 
instructions. 

2.2.5 Installing the 900-LC Series HPLC Driver 
The drivers work with the Galaxie core software to provide 
instrument control and data acquisition. Install this driver on the 
main server and each acquisition server and client PC that will be 
working with the 900-LC Series HPLC system. 

✒ Note If you have purchased the single system Galaxie software license, 
open Galaxie Configuration Manager and delete the Default 
system that is created during the Galaxie software installation. For 
information on how to delete a system please see section 2.2.8, 
Deleting a System, page 31. 

✒ Note Before installation you must have the HPLC system set up and 
turned on. Set up includes having the network cabling and 
hardware plugged in. 
To install the 900-LC Series HPLC Driver: 

1. Insert the 900-LC Series Galaxie Driver CD into your CD-
ROM drive. The software will automatically start1. 

2. Click Next on the Welcome to Install Shield Wizard for Varian 
Series 900-LC Drivers window. 

3. Click Yes to accept to the License agreement. Clicking no will 
terminate the program. 

                                                      
1 If you have turned off the auto-start capability of your CD-ROM drive, you will need to run the setup.exe file on the  
CD-ROM. 
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4. Enter in your name, the company name, and the serial 
number of the 900-LC Series HPLC Driver CD (p/n 
8510244200) or the serial number from the Galaxie Control 
Software for Varian HPLC Systems CD (p/n 0395000491). 
The serial number is provided on your Varian HPLC driver’s 
serial number card or Galaxie software CD and is different 
from the Galaxie serial number.  

5. For installations of the new Varian 900-LC Driver with an 
existing Galaxie Varian HPLC driver only: If you need to look 
up existing serial number in the Galaxie software first login to 
the Galaxie Configuration Manager then select the "options" 
menu and then select the option "Licenses"... 

The installer begins to install the driver files onto the PC. 
6. Click Yes to install the Flash Player. 

✒ Note If you click No, you will not get the full functionality of the 900-LC 
Series HPLC driver; however, Flash is not required to run the 900-
LC. 
7. Click Close on the Flash Player 9 Installer Setup: Completed 

window to continue the installation. 
8. Click Next on the Welcome to Microsoft™ .NET Framework 

2.0 Setup window. 
9. Read and then accept the terms of the License Agreement 

and then click Install on the End-User License Agreement 
window. 

10. Click Finish to complete the Microsoft™ .NET Framework 2.0 
installation. This process can take several minutes. 

11. Click Yes to install Adobe Acrobat Reader.  

✒ Note If you click No, installing Adobe Acrobat Reader will be skipped. 
However, you may not be able to view any accompanying PDF 
report files or help files. 
If you click Yes and the Repair/Modify window appears, Adobe 
Acrobat Reader is already installed on your PC. Click Cancel to 
stop the Adobe Acrobat Reader installation or click Repair to re-
install. 
12. Click Next on the Destination Folder window. 
13. Click Install on the Ready to Install the Program window. 
14. Click Finish to complete the Adobe Acrobat Reader 

installation. 
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2.2.6 Installing the 900-LC Series HPLC Help  
This step is a continuation from the previous section, Installing the 
900-LC Series HPLC Driver. 
To install the 900-LC Series HPLC Help: 
1. Remove the driver CD and insert the 900-LC Series HPLC 

Help CD when instructed. Click OK. If you click Cancel, a 
message will appear confirming your choice not to install the 
Online Help. Click No to exit the installation or click Yes to 
continue installing the Online Help. If the CD Windows™ 
Explorer window appears, close it. 

2. Click OK to continue the installation. 
3. Click Next on the Welcome to the Varian 900-LC Series 

HPLC Help Setup Wizard window.  

✒ Note This window may be behind the 900-LC Series system 
configuration window. Do not close the 900-LC Series system 
configuration window. Move it out of the way until it is needed. 
4. Click OK to accept the default installation location or choose a 

different location to install a shortcut to the Online Help. 
5. Click on Finished. 

2.2.7 Configuring the 900-LC Series HPLC System(s) 
This step is a continuation from the previous section, Installing the 
900-LC Series HPLC Help.  
To use this setup wizard after the installation process, access this 
setup program by navigating to 
C:\Galaxie\Server\Devices\SetupWizard.exe. Double click 
SetupWizard.exe to launch the setup program or please see the 
Galaxie Configuration Manager online help. 
To access the Galaxie Configuration Manager Online Help: 
Click the Windows® Start button and choose Programs > 
Galaxie™ (Chromatography) > Help > Galaxie™ Configuration 
Manager.  
Systems should only be configured on an acquisition server or a 
stand-alone PC configuration. 

✒ Note This setup wizard will allow all Groups, Projects and Users defined 
in Galaxie Configuration Manager to access this system. 
To configure the 900-LC Series HPLC System(s): 
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1. Click Yes to configure a system if you are installing on an 
Acquisition server or on a Stand-Alone system. If you choose 
No, the installer will exit. 

2. The 900-LC Series Setup Wizard window appears. Enter in 
the name of the system. This is the system name that will be 
displayed in the browser window of the Galaxie software. 

✒ Note Ensure you have typed in the correct system name. To modify 
a system name later you must first delete that HPLC system, 
see page 31, and then use this SetupWizard.exe to recreate 
the HPLC system. 

3. Click on the magnifying glass icon  to start the system 
discovery process. This can take up to 5-10 seconds. 

4. Click the down arrow button in the Instrument field to select 
the HPLC system. 

✒ Note Identify the system by the MAC address which can be found on 
the back of the HPLC system and in your documentation that 
came with the HPLC system. 

Once the system is chosen, IP address information will be 
automatically entered into the IP address, Subnet mask, and 
Default gateway fields. This information will be what the instrument 
was shipped with and may not be appropriate for your use. 
7. Choose Obtain an IP address automatically (DHCP) or Use 

a static IP address. 
(a) When Obtain IP address automatically (DHCP) is 

chosen, the system will search for an IP address 
automatically. If one is not found, click Retry. The 
Switching to DHCP mode window pops up. Click 
Initialize instrument. This will reboot the HPLC system 
communications card. Click Close when the initialization 
is complete. 

✒ Note If an IP address still does not appear, contact your IT department 
to check your network connections. The HPLC systems must be 
on the same gateway/subnet as the acquisition server or stand-
alone PC configuration and be connected to the provided Ethernet 
switch. 

(b) When Use a static IP address is chosen, enter in the IP 
address, Subnet mask, and Default gateway for the 
HPLC system. The HPLC systems must be on the same 
gateway/subnet as the acquisition server or stand-alone 
PC configuration and be connected to the provided 
Ethernet switch. 
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8. Click Create. 
9. Click OK when the message confirming the system creation 

comes up. 
10. Create up to three more systems or click Close to exit the 

installer. 
11. Click Yes or No to the question ‘Do you want to give the right 

“Allow to run instrument maintenance software’ to ALL of the 
Galaxie user profiles?’. This will provide access to the 
Instrument Maintenance Software (IMS) for all profiles. See 
page 35 for more information on IMS. For most unregulated 
installations click Yes. 

✒ Note To configure IMS access for individual profiles use Galaxie 
Configuration Manager. 

12. If Yes was clicked in step 11, click OK at the All user profiles 
have been changed window. 

13. Click Finish on the InstallShield Wizard Complete window. 

2.2.8 Deleting a System 
If the system needs to be renamed or the IP address changed you 
will need to delete the existing system and recreate it. 
To delete a system: 

1. Open Galaxie Configuration Manager. 

2. Click the Windows® Start button and choose Programs > 
Galaxie™ > Galaxie™ Configuration Manager. 

3. Log in to Galaxie Configuration Manager. 

4. Click Systems in the upper left side of the window. 

5. Right click the system to be deleted and choose Delete. 

6. Click Communication engine configuration on the lower left 
side of the window. 

7. Highlight the first line with the system name to be deleted and 
then click Remove on the upper right side of the window. 

8. Click Yes to delete the hardware configuration. 

9. Repeat the previous step for all entries prefaced with the 
system name to be deleted. 
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10. If your changes are not showing in Galaxie Configuration 
Manager, press F5 on your keyboard or View and then 
Refresh to refresh the window. 

11. Click Interface configuration on the bottom left side of the 
window. 

12. Highlight the first line with the system name to be deleted and 
then click Remove on the upper right side of the window. 

13. Repeat the previous step for all entries prefaced with the 
system name to be deleted. 

14. Click Apply. 

15. Exit Galaxie Configuration Manager. 

2.2.9 Change the 900-LC Series HPLC System Name or IP 
Address 

You cannot change the name or IP address of an HPLC system. 
You must delete the system first and then re-create it using the 
SetupWizard.exe. 
To change the name or IP address of a system: 

1. Delete the HPLC system. See section 2.2.8 for instructions. 

2. Re-create the HPLC system. See section 2.2.7 for 
instructions. 

2.2.10 Update Galaxie to Version 1.9 SP1 
The 900-LC Series HPLC Driver requires Galaxie version 1.9 SP1 
to run. The ordering information for the CD is part number 03-
950000-98 (Galaxie Software Service Pack 1 (SP1) CD). This CD 
is only available for Galaxie software version 1.9. 

✒ Note Contact your local Varian representative to upgrade Galaxie 
version 1.8 to 1.9 SP1. This CD will not update Galaxie version 1.8 
to 1.9 SP1. 
To update to version 1.9 SP1: 

1. Insert the CD into your CD-ROM drive. 

2. Click Next on the Welcome screen. 
The updater will install and update the required files. 

3. Click Yes to restart your PC. 
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4. Click Finish to restart the PC. 
When the restart has completed a window will appear asking for 
the Main server name if you are performing a Client/Server 
installation.  

5. Enter the main server name into the field. 

✒ Note You must update all PC’s in the Galaxie network. Always update 
the main server first. 

✰✰✰ Hot Tip To familiarize yourself with the Galaxie™ software, after 
installation, click the Windows® Start button and choose 
Programs > Galaxie™ > Galaxie™ Help. 

2.3 About the Varian 900-LC Series HPLC Online Help 
Throughout this manual references are made to the Varian 900-LC 
Series HPLC online help or Galaxie™ Chromatography Data 
Systems help. 
The Varian HPLC system online help is provided on a separate CD 
to the Galaxie™ software and is installed on your PC during the 
Galaxie™ software installation. 
The HPLC system help includes information and instructions on: 
• Safety 
• HPLC system standard and optional hardware 
• Installation of the HPLC system options and components 

including the: 
• Hardware 
• HPLC system driver for the Galaxie™ software 

• Creating methods 
• Viewing run details 
• Saving the run 
• Maintenance 
• Troubleshooting 
• Spares and options 

2.4 Hardware Installation 
Your HPLC system will be ready to operate after the Varian 
representative has installed it. However, over time you may need 
to replace some hardware components such as detector lamps, 
autosampler needles, etc or may need to install a new device to 
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your HPLC system. For instructions on how to do this, please refer 
to the online help. Specifically: 

1. Click the Windows® Start button and choose Programs > 
Galaxie™ > Help > Varian 900-LC Series HPLC Help. 

2. When the Online Help appears, click the How to > Installing 
Components link to access step-by-step instructions on how 
to remove and install the various instrument components. 

For information on your instrument connections including 
connecting the network and communication cables please refer to 
the online help. 

1. Click the Windows® Start button and choose Programs > 
Galaxie™ > Help > Varian 900-LC Series HPLC Help. 

2. When the Online Help appears, click About Your Instrument 
link to access information about the front, side and back 
connections and components of your HPLC system. 

2.5 Installation System Test 
Your Varian representative will perform a system test during the 
installation procedure. 
You can find the results of the system test in the Log Book. The 
Log Book is a list of all actions, counters and tests performed on 
your HPLC system. The saved file can be found in your My 
Documents folder on the PC the system test was performed, or in 
the Log Book tab in the IMS software. It is recommended you save 
those results as a record of your instrument performance at 
installation. 
If you purchased a separate AIQ package, please refer to the 
documentation provided with the AIQ package for more 
information. 

2.6 Customer Training 
During the installation process you will receive basic training on 
how to: 
• set up the hardware 
• use the Galaxie™ software 
• use the Online Help 
• use the IMS software. 
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2.7 Using the Varian 900-LC Series HPLC Online Help 
The online help is context sensitive. Pressing the F1 key on any 
screen in the device control section of the Galaxie™ software will 
bring up help that relates to that screen. 
Alternatively, you can access the online help by: 

1. Click the Windows® Start button. 

2. Click Programs. 

3. Click Galaxie™. 

4. Click Help. 

5. Click Varian 900-LC Series HPLC Help. 

2.8 Instrument Maintenance Software (IMS) 
IMS software is used to keep track of any maintenance performed 
on the HPLC system and usage over time of components within 
each device in your HPLC system.  
IMS has several features: 
• Counters which record component usage 
• Actions which lists all procedures that can be tracked 
• The Log Book lists all actions and counter information and can 

be saved in a PDF file 
• Service tests which can test the performance of devices in the 

HPLC system. 

2.8.1 How to Access IMS 
Access the Instrument Maintenance Software from the link on the 
right side of the Status Overview window in the Galaxie™ 
software. The Instrument Maintenance software can be run with 
the Galaxie™ version 1.9 SP1 or greater. When the logon window 
appears, enter a User identification, and choose the group and 
project in which the system to be maintained is defined in Galaxie. 
Type the corresponding password. The password is case sensitive 
(abc ≠ ABC). 
To be able to log into the Instrument Maintenance Software, 'allow 
to run instrument maintenance software' must be checked in the 
Acquisition/system properties part of the user profile in the Galaxie 
Configuration Manager software. If the user does not have the right 
to run maintenance software an error message is displayed. 
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To enable IMS access: 
1. Open and log in to the Galaxie Configuration Manager 

software. 
2. Click User profiles. 
3. Right click on the user profile to be edited and choose 

Edit. 
4. Click Next. 
5. Click the + sign next to Acquisitions/System properties to 

expand the list. 
6. Select Allow to run instrument maintenance software 

and any other tasks required by the user. 
7. Click OK to save the changes. 

2.8.2 About IMS 
The software has the menu bar at the top which includes: 
• File 

• Open Audit trail  

• Save Audit trail  

• Preview Audit trail  

• Print Audit trail  
• Quit 

• View 
• Actions 

• Maintenance mode ON  

• Maintenance mode OFF  
• About 
For detailed information about the IMS software please see the 
900-LC Series HPLC online help. 
To access the online help: 

1. Click the Windows® Start button. 

2. Click Programs. 

3. Click Galaxie™. 

4. Click Help. 
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5. Click Varian 900-LC Series HPLC Help. 

6. Click Instrument Maintenance Software in the online help 
table of contents. 

For information on audit trails: 

1. Click the Windows® Start button. 
2. Click Programs. 
3. Click Galaxie™. 
4. Click Help. 
5. Click Varian 900-LC Series HPLC Help. 
6. Click the plus sign next to Instrument Maintenance 

Software in the online help table of contents. 
7. Click Audit Trails. 
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3. Operation 

You will find step-by-step instructions for common operations in the 
900-LC Series HPLC Help. To access this information: 

1. Select the Windows® Start button and choose Programs > 
Galaxie™ > Help > Varian 900-LC Series HPLC Help. 

2. When the Online Help appears, click the How to link to view 
the available step-by-step instructions. 

Below is a quick guide to getting the instrument set up and running 
samples. 

3.1 Analysis Checklist 
You need to complete the following steps in turn to measure a 
sample/s. You will find details on each step in this chapter. 
• Turn on the instrument and software 

• Prepare the instrument for use 

• Configure the Device Settings and System Parameters 

• Create a method 

• Run samples 

• View or Print a report 

3.2 Turning on the Instrument and Software 
Before starting the system, carefully read the Safety practices and 
hazards section at the front of this manual and ensure that the 
laboratory is set up according to the details specified in the  
Pre-installation manual. 
To turn on the instrument and software: 

1. Switch on the computer, monitor and printer. 

2. Turn on the HPLC system. 
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3. To start the Galaxie™ software, click the Windows® Start 
button and then choose Programs > Galaxie™ > Galaxie™. 

4. Enter in your login details and click OK. 

3.2.1 Connecting to a System 
Depending on the configuration you purchased, you may have up 
to four HPLC systems connected to one PC. Due to this flexibility 
in the software, you must connect to a system when you open the 
Galaxie™ program. 
To connect to a system: 

1. Click the Systems tab at the bottom left of the main Galaxie™ 
window. 

2. Select the empty box next to your system. 
Your Galaxie™ software will automatically begin communicating 
with your HPLC system. 

✒ Note There will be a delay between choosing your system and the 
system information appearing on your screen. The Galaxie™ 
software is communicating with the HPLC system. 

3.3 Preparing the System for Use 
For consistent and reproducible results each time you use the 900-
LC Series HPLC it is recommended that you follow this procedure 
to prepare your system to run samples. 
To prepare the system for use: 

1. Check that all tubing to the column(s), pumps, and waste is 
correctly connected and in the proper position. 

2. Place all samples into the autosampler tray. Cool the tray prior 
to placing samples into it if necessary. 

3. Close the HPLC system doors. 

4. Check that all tubes are placed in the fraction collector (if 
necessary). 

5. Set the flow rate manually to remove any air bubbles or old 
solvent from the system. 

6. Purge the pumps if new solvent is being used. 
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7. Purge any air bubbles from the autosampler injection valve if 
necessary. 

8. Turn on the column heater and allow the column(s) to come to 
the correct temperature if necessary.  

 

Caution It is imperative that whenever the column heater is turned on, the 
pump should be running with a non-absorbing solvent flowing 
through the column to avoid column degradation. 

 

9. Turn the detector lamp(s) on. 
 

Caution It is imperative that whenever the Varian detector lamp is turned 
on, the pump should be running with a non-absorbing solvent 
flowing through the cell, with no air bubbles present. 

 
For more information on getting your system prepared for use 
please see the 900-LC Series HPLC Help. 

1. Click the Windows® Start button. 

2. Click Programs. 

3. Click Galaxie™. 

4. Click Help. 

5. Click Varian 900-LC Series HPLC Help. 

6. Click the plus sign next to How To…. 

7. Click Prepare the HPLC System For Use. 
 

3.4 Configuring the Device Settings and System 
Parameters 

The Device Settings allow you to program settings for each 
component within your 900-LC Series HPLC as well as control flow 
rates, purge the pumps, turn the detector lamps on, heat the 
column oven and move the autosampler needle and fraction 
collector probe. 
The System Parameters are settings that will download directly to 
your method. They include information such as the pressure units 

Publication no. 8510243600, Issue 1, February 2008  Page 41 of 54 



Varian 900-LC Series Liquid Chromatograph 

to be displayed on screen, autosampler rack size, fraction collector 
rack sizes, leak detection actions, pump head size, sample loop 
size, and enabling the cooling on the autosampler trays. 
For additional information on your system components please see 
the 900-LC Series HPLC Online Help. 

3.4.1 Flows 
In Flows you can: 
• manually set and turn on your flow rate and solvent 

composition 
• purge the pumps 
• set the bottle management parameters 
• select the solvents for the Scale Up Module valves (if present 

in your system) 

3.4.2 Detectors 
Depending on the detector you purchased, in the detector Device 
Settings you can: 
• choose wavelengths 
• autozero the detectors 
• turn your detector lamp(s) on 
• choose the data collection parameters 
• set the detector temperature conditions. 

3.4.3 Column 
Depending on the column options you purchased you can: 
• set the column heater temperature 
• turn the heater on 
• choose the scale up module column 
• choose between two columns if a column switching valve is 

present 
• view the column properties of your column if you have 

downloaded your method to the HPLC system. 
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3.4.4 Sample Introduction 
Sample introduction can occur by using an autosampler or manual 
injector if you are running an analytical or analytical to semi-
preparative HPLC. If you are running a preparative scale HPLC 
system samples are introduced using a manual injector or by a 
Thru Pump Injector. 
Autosampler 
If you purchased an analytical or analytical to semi preparative 
system you may have an autosampler.  
In the Autosampler Device Settings you can move the needle to 
the: 
• wash port  
• injection port 
You can also flush the syringe barrel to replace solvent or remove 
bubbles by clicking the Flush Syringe Barrel button. 
If you have the cooling option on your autosampler you can 
change the temperature. 
Manual Injector 
Depending on the options you chose, you may have a manual 
injector. This allows you to make single injections. The Device 
Settings window lets you make an injection and shows you the 
state of the injector. 
Injection Pump 
The preparative scale HPLC system will have an injection pump. In 
the injection pump method you can program the injection volume 
and flow rate. 

3.4.5 System Parameters 
System Parameters are settings that affect new methods. If you 
change the System Parameters while a method is already open, 
the changes will not affect that method.  
Depending on the system you purchased you can: 
• set the units preferred for the pressure and set the cell ratio if 

using a semi-prep or prep cell 
• edit the manual injector options including the reset time, 

analytical (SUM) loop size and preparative loop size 
• edit the reset time for a manual injector which is used to switch 

the valve back into the idle position 
• enable the rack cooling option in the autosampler section 
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• select normalization for the PDA detector  
• set the option to turn the lamps on as the detector(s) power up 
• choose synchronize with other modules send a contact closure 

to external devices 
• choose which leak detector action will be performed when a 

leak is detected 
• choose solvents to be used in the valve module section if you 

have a Scale Up Module 
• with semi-prep and prep systems you can choose the pump 

head sizes, sample delivery pump head size and pressure 
units 

• in the fraction collector section you must choose your rack 
type, tube volume and probe depth 

• save your settings 

3.5 Creating a Method 
To create a new method: 

1. Click File > New > Method in the upper left corner of the 
Galaxie™ software.  

2. Choose the Project Name and System name from the drop-
down menus and then click Next. 

3. Enter the Method Name and Description and then click OK. 

✒ Note Galaxie™ will open to the main method screen on the Integration 
Events tab. 

4. In the lower left corner click on control. 

✒ Note The Galaxie™ software will show the Device Select window. You 
should see a list of your system components just to the left of the 
Device Select window. 

5. Choose the devices needed for your run by selecting or 
deselecting the options in the Device Select window. 

6. On each device window set your parameters. 

✒ Note Your System Parameters will automatically appear in your method. 
All other settings will need to be checked. 

7. Click acquisition in the lower left corner of the Galaxie™ 
software. 
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8. Click on the button with the three dots next to the File prefix 
field to open up variable options for your run name. Double 
click the variables to be used in your run name or type in a 
name for your run and then click OK. 

9. Set the identifier number if something other than 1 is required 
to name the run. 

10. In the Acquisition Parameters section enter in the Vial and 
Rack number if an autosampler is to be used, the Acquisition 
length and Injection Volume. 

✒ Note For information about the additional fields in the Acquisition 
window please see your Galaxie™ Chromatography Data System 
software Online Help. 

1. Click File > Save > Save Method. The method will now be 
saved in the default data folder. 

For more information on creating a method please see the 900-LC 
Series HPLC Help. 

1. Click the Windows® Start button. 

2. Click Programs. 

3. Click Galaxie™. 

4. Click Help. 

5. Click Varian 900-LC Series HPLC Help. 

6. Click the plus sign next to Software. 

7. Click Galaxie software tutorial for a basic overview of the 
main Galaxie windows. 

8. Alternatively, click the plus sign next to How To… 

9. Click Program a method from start to finish for a step by 
step tutorial on how to program a method. 

3.6 Starting an Acquisition 
There are two ways to start an acquisition. You can have multiple 
injections by creating a sequence or single injections using Quick 
Start. 

Publication no. 8510243600, Issue 1, February 2008  Page 45 of 54 



Varian 900-LC Series Liquid Chromatograph 

3.6.1 Sequence 
1. From the File menu click New > New Sequence. 

2. Choose the Project name and System name to be associated 
with this sequence and then click Next. 

3. Enter the number of lines (number of samples) in the 
sequence and then click Next. 

4. Enter the new sequence name and a description if needed 
and then click OK. 

✒ Note A window appears with the number of lines you chose in step 3. 
You can auto-fill the columns by entering or choosing a value in 
the first line and then right clicking the heading of that column. 
Choose Fill Block and then follow the prompts. Alternatively you 
can manually fill in each field to customize your sequence. 

1. Enter in all required fields. 

2. Click File > Save > Save Sequence. 

3. On the Sequence page, click the green arrow button to start 
the sequence. 

4. To view your runs click the Systems tab on the bottom left of 
the Galaxie™ software. 

✒ Note For further information about starting an acquisition and 
interpreting the results, refer to the Galaxie™ Chromatography 
Data System Online Help. 

3.6.2 Quick Start 
To start a Quick Start run: 

1. Click Acquisition on the top menu bar. 

2. Choose Quick Start. 

3. Select the Project name, System name and Method name and 
then click OK. 

4. Click on the button with the three dots next to the File prefix 
field to open up variable options for your run name. Double 
click the variables to be used in your run name or type in a 
name for your run and then click OK. 
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5. Set the identifier number if something other than 1 is required 
to name the run. 

6. In the Acquisition Parameters section enter in the Vial and 
Rack number if an autosampler is to be used, the Acquisition 
length and Injection Volume. 

7. Click the Start button. 

8. To view your run click the Systems tab on the bottom left of 
the Galaxie™ software. 

✒ Note For further information about running samples and interpreting the 
results, refer to the Galaxie™ Chromatography Data System 
Online Help. 

3.7 Printing a report 
To print a report: 

1. Click Report Style in the lower left corner of the Galaxie™ 
software. 

✒ Note When printing a report, you can simply select Print from the File 
menu. However, if you do so, a report will be generated based 
upon the last used Report Settings. You will not be able to select 
the data to be included in the printout. 

2. Choose a report style or edit a style. 

✒ Note For more information on how to edit report styles please see the 
Galaxie™ Chromatography Data System Online Help. 

3. Click File > Print to generate a report as specified. 

4. The Print dialog box will open. You can select to print all of the 
report, or a range of pages. Reports are printed to your default 
printer, unless you specify otherwise. You can specify your 
printer options in the Print Setup dialog box, accessible from 
the File menu. 

As the Print dialog is a standard Windows® dialog, you can obtain 
“What’s this” help on an item by clicking the question mark icon in 
the top right corner and then clicking the item of interest.  

3.8 Saving Your Files 
There are two ways to save a file. 
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• Save a file with the same name (overwriting the previous one) 
by using the menu File > Save / Save file type 

• Save the file with another name by using the menu File > Save 
As / Save file type As.  

In both cases, the Galaxie™ Software prompts as default to save 
the file type corresponding to the active file. 
The Save file window displays the list of the files already created in 
the directory associated with the group (when the user is logged on 
to All projects) or with the project (when the user is logged on to a 
specific project). 
Access the sub-directories by double-clicking on the corresponding 
folder icon. Once inside the sub-directory, the path is displayed at 
the top of the window. 
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4. Maintenance 

This chapter includes information on how to access the Varian 
900-LC Series HPLC system maintenance requirements that may 
be carried out by an operator. Any maintenance procedures not 
specifically mentioned should be carried out only by Varian-trained, 
Varian-qualified or Varian-authorized representatives. 
 

 

Warning 
The UV-Vis, PDA and Fluorescence detector lamps are intense 
light sources. Direct viewing of the light source will cause eye 
damage. Operators and other unauthorized personnel must 
NEVER remove the main covers. 

 

 

Warning 
This instrument contains electrical circuits, devices and 
components operating at dangerous voltages. Contact with 
these circuits, devices and components can result in death, 
cause serious injury, or painful electrical shock. 

 

 

Warning 
Allow hot parts to cool before proceeding with any maintenance 
procedure. 
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Warning 
There is a danger of ignition when using flammable chemicals 
such as organic solvent. Aqueous solvents or organic solvents 
having an ignition point above 70 °C can be used. Do not use 
organic solvents having an ignition point below 70 °C. 

Be careful about ignition due to static electricity when using 
flammable chemicals. Use a conductive vessel and carry out 
grounding correctly, especially when using a non-conductive 
chemical. This instrument is not explosion-proof. 

 

 

Warning 
Always check the flow path for leakage of solvent or waste 
solution during use and leakage of solvent inside the instrument. 
If an abnormality is found, stop the operation immediately. 

Provide sufficient ventilation in the room. 

Use of the HPLC system and accessories may involve materials, 
solvents and solutions which are flammable, corrosive, toxic or 
otherwise hazardous. Careless, improper or unskilled use of 
such materials, solvents and solutions can create explosion 
hazards, fire hazards, toxicity and other hazards that can result 
in death, serious personal injury or damage to equipment. 

 

✒ Note This section refers only to maintenance procedures for the 
instrument. You should refer to your PC and printer manuals for 
their maintenance procedures and to the 900-LC Series HPLC 
Help for the maintenance procedures for any accessories you 
ordered. 

4.1 Routine Maintenance 
Routine maintenance information is provided in the 900-LC Series 
HPLC online help. To access these instructions: 

1. Click the Windows® Start button. 

2. Click Programs. 

3. Click Galaxie™. 
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4. Click Help. 

5. Click Varian 900-LC Series HPLC Help. 

6. Click the Maintenance link. 

7. Click Checklist. 

4.2 Cleaning 
Any spills in the sample compartment or on the HPLC system 
should be wiped up immediately. 
The exterior surfaces of the instrument should be kept clean. All 
cleaning should be done with a soft cloth. If necessary, this cloth 
can be dampened with water or a mild detergent. Do not use 
organic solvents or abrasive cleaning agents. 

4.3 Spare Parts 
For spare parts and consumables ordering information, refer to the 
Varian, Inc. Web site: 
www.varianinc.com 
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5. Troubleshooting 

For troubleshooting help please refer to the Varian 900-LC Series 
HPLC online help. 
To access the online help troubleshooting section: 

1. Click the Windows® Start button. 

2. Click Programs. 

3. Click Galaxie™. 

4. Click Help. 

5. Click Varian 900-LC Series HPLC Help. 

6. Click the Troubleshooting link for general HPLC system 
troubleshooting or click the plus sign next to Troubleshooting 
to access the device troubleshooting information. 

 

Publication no. 8510243600, Issue 1, February 2008  Page 53 of 54 



Varian 900-LC Series Liquid Chromatograph 

This page is intentionally left blank. 

Page 54 of 54  Publication no. 8510243600, Issue 1, February 2008 


	General
	Electrical Hazards
	Compressed Gas Cylinders
	Storage Cylinder Instructions

	High Pressure Hazards
	Ultraviolet Radiation
	Solvent Hazards
	Ignition of Flammable Chemicals
	Inflammation or Injury Due to Toxic, Corrosive or Stimulativ

	Other Precautions
	Warning and Caution Messages
	Warning Symbols
	Color Coding
	US FCC Advisory Statement
	Spurious and Harmonic Radiation Compliance
	CE Compliance
	Introduction
	Pre-installation Requirements
	User Documentation
	Conventions
	Notes and Hot Tips

	Specifications
	Environmental Conditions
	Electrical Power Supplies
	900-LC Series HPLC System Power Connections
	Fuses
	Electrical Requirements

	Gas Supplies
	Storage Cylinder Instructions

	Waste Container
	Laboratory Conditions
	Instrument Cooling Air Supply
	Weights and Dimensions

	Personal Computer Requirements

	Installation
	900-LC Series HPLC System to PC Communications
	Installing the Galaxie™ Chromatography Data System Software
	Software Components Requiring Installation and Serial Number
	Galaxie CDS Client/Server Installation Information
	Galaxie Workstation Stand-alone Installation Information
	Galaxie Installation Procedure
	Installing the Galaxie CDS Core Software
	Installing Galaxie or Other HPLC or GC Device Drivers

	Installing the 900-LC Series HPLC Driver
	Installing the 900-LC Series HPLC Help
	Configuring the 900-LC Series HPLC System(s)
	Deleting a System
	Change the 900-LC Series HPLC System Name or IP Address
	Update Galaxie to Version 1.9 SP1

	About the Varian 900-LC Series HPLC Online Help
	Hardware Installation
	Installation System Test
	Customer Training
	Using the Varian 900-LC Series HPLC Online Help
	Instrument Maintenance Software (IMS)
	How to Access IMS
	About IMS


	Operation
	Analysis Checklist
	Turning on the Instrument and Software
	Connecting to a System

	Preparing the System for Use
	Configuring the Device Settings and System Parameters
	Flows
	Detectors
	Column
	Sample Introduction
	System Parameters

	Creating a Method
	Starting an Acquisition
	Sequence
	Quick Start

	Printing a report
	Saving Your Files

	Maintenance
	Routine Maintenance
	Cleaning
	Spare Parts

	Troubleshooting


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


